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Découverte de Maya 
 
 
Maya comme Maya PLE inclut des petites séquences vidéo d’introduction à 
l’interface du logiciel. Vous pouvez les consulter. Elles sont généralement proposées 
au lancement dans une fenêtre pop-up intitulé : « Learning Movies ». Vous pouvez la 
retrouver dans le menu « Help – Learning movies ». 
 
 
LES VUES 
 
Elles correspondent aux écrans qui nous représentent la scène et les objets s’y 
trouvant. Elles sont associées à des caméras. Au démarrage, le logiciel crée des 
caméras par défaut qui permettent de commencer à travailler rapidement. La barre 
espace permet de permuter entre le mode « quatre vues » et le mode « vue 
unique ». Quand vous êtes en mode « quatre vues », la vue où se trouve le pointeur 
souris sera basculée en vue principale lors de l’appui sur la barre espace. 
 
 
 

     
 
 
 
Il existe trois vues type correspondant aux trois axes principaux (x,y et z). Elles sont 
appelées orthographiques (front, side et top). Vous n’avez pas le droit de changer 
leur angle de vue, il est fixe par définition. Pour effectuer des rotations, il faut utiliser 
les vues perspectives (pers). Vous pouvez demander de nouvelles vues en 
perspective, cela aura pour effet de créer une nouvelle caméra (visible cette fois). 
Tout cela est possible en cliquant sur Panels > Perspective/Orthagraphic  
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Pour la manipulation d’une vue, nous rappelons brièvement les commandes : 

• ALT + LMB : rotation 

• ALT + MMB : translation 

• ALT + RMB : zoom 

• Roulette : zoom rapide 
 
MODE DE VISUALISATION DANS LES VUES 
 
Dès que votre scène va comprendre plusieurs centaines d’objets, l’information à 
afficher va commencer à être conséquente. Par conséquent, on peut choisir 
comment afficher les objets dans les scènes, chaque mode étant plus ou moins 
raffiné et donc plus ou moins lent. Les commandes s’effectuent avec les touches du 
clavier numérique. 
 
 
Les touches 4,5 et 6 vont correspondre respectivement aux modes fil de fer, surfaces 
opaques et surfaces texturées. Ils s’appliquent à l’ensemble des objets mais 
uniquement dans la vue active. Voici un exemple ci-dessous : 
 

            
                   Fil de fer            Opaque + éclairage          Opaque + textures 
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Les touches 1,2 et 3 (attention au NUM-LOCK) correspondent à la basse, moyenne 
et haute qualité d’affichage dans les vues 3D. Pour appliquer ce mode, il faut déjà 
sélectionner les objets concernés (ils doivent devenir vert clair). Cette fonctionnalité 
n’est effective que pour les NURBS (surface paramétrique). En effet, comme les 
cartes graphiques n’affichent que des polyèdres, il faut à un moment que le 
programme convertisse les NURBS en polyèdres pour les transférer à la carte 3D. 
Cette mécanique n’est valable que pour les vues 3D et elle n’influe en rien votre 
surface, vos calculs d’image et toute autre chose. Ne pensez pas que votre NURBS 
est devenu un polyèdre parce qu’elle y ressemble fortement alors qu’en fait vous 
avez juste demandé un affichage de votre NURBS en basse qualité. 
 

 
Différents niveaux de qualité de visualisation d’une NURBS sphère 

 

         
                Basse qualité    Moyenne Qualité               Haute Qualité 
 
 
  
RESET DE L’INTERFACE 
 
Alerte !! Je viens d’appuyer sans le faire exprès sur l’icône de fermeture d’une barre 
d’outils, d’un menu… La solution la plus simple est d’appuyer deux fois sur CTRL-
Espace pour la réinitialiser complètement… ouf, elle redevient comme lors de 
l’ouverture du logiciel. 
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LES OUTILS PRINCIPAUX 
 
 
Les quatre outils principaux sont : 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
Ces outils sont utilisables dans toutes les fenêtres de Maya, c’est-à-dire pas 
seulement dans les vues 3D. Cette généricité rend très conviviale l’interface. 
 
Tous ces outils ont en commun les manipulateurs qui apparaissent dans l’interface 
dès qu’un élément est sélectionné : 
 
 
 

   
         Translation         Rotation    Homothétie 
 
 
 
Les trois couleurs spécifiques  (rouge, vert, bleu) correspondent aux axes respectifs 
x, y et z. Ainsi si vous sélectionnez un manipulateur particulier, vous désactivez 
automatiquement les autres et le manipulateur sélectionné devient jaune. Ainsi si je 
sélectionne le manipulateur flèche verte pour la translation, il devient jaune et après 
tous les mouvements que je fais se feront uniquement dans l’axe des y. Cette 
translation est dite « contrainte » dans cette direction. 
 

 
La sélection : 
 
 
 
 
 

La translation : 
 
La rotation : 
 
L’homothétie : 
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                    Manipulateurs R/V/B                        Manipulateur sélectionné 
 
 
On ne peut dans une interface 2D représentant une vue 3D savoir exactement les 
déplacements effectués si l’on bouge notre objet sans appliquer de contraintes. Il est 
donc fortement recommandé pour une quelconque manipulation, de la faire en 
utilisant un manipulateur, puis un deuxième puis un troisième pour contrôler 
exactement les modifications sur chaque axe. Ainsi seulement, nous savons ce qui a 
été effectué. 
 
 
 
Il se peut que les manipulateurs vous gênent en vous empêchant de sélectionner 
l’élément que vous désirez !! Dans ces cas là, le plus simple est d’utiliser les touches 
+ et – pour les réduire ou pour augmenter leur taille : 
 
 
 

     
 
 
 
OUTIL SELECTION 
 
En faisant varier les modes de l’outil sélection, vous interagissez sur différents 
éléments d’un objet. Vous obtiendrez les résultats suivants : 
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 F8 : sélection des objets (les objets sélectionnés sont alors affiché en VERT CLAIR) 
dans tous les autres modes, ils sont en BLEU 
 
 

 
 
 
F9 : sélection des sommets (les sommets sont entourés d’un carré violet, une fois 
sélectionné, ce carré apparaît en jaune) 
 
 

 
 
 
F10 : Sélection des arêtes (pas de signe caractéristique pour ce mode, c’est donc ce 
qui le caractérise !! une fois sélectionnée, l’arête apparaît orangée) 
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F11 : Sélection des faces (chaque face est marquée par un carré permettant de la 
sélectionner, une fois sélectionné, le carré et les arêtes adjacentes de la face 
deviennent orangées) 
 
 

             
 
 
 

ATTENTION. Chacun de ces modes affectent ENORMEMENT les opérations que 
vous effectuez. Par exemple, si vous sélectionnez un sommet de votre cube et que 
vous appuyez sur DEL dans l’intention de supprimer votre cube entier, il ne se 
passera rien. En effet, il n’est pas possible de détruire ce vertex et si vous voulez 
détruire l’objet entier, il faut sélectionner cet objet et pour cela il faut être en mode 
OBJET !!!  Il en est de même, par exemple, si vous voulez accéder aux attributs de 
l’objet, si vous êtes en mode sommet, vous n’y aurez pas accès. 
 
 
OUTIL ROTATION 
 
Pour cet outil, il apparaît un quatrième cercle correspondant à une rotation effectuée 
par rapport à la vue courante. Une fois de plus, cette manipulation ne permet pas de 
contrôler précisément ce qui se passe, donc elle reste à éviter.  
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OUTIL HOMOTHETIE 
 
Ses manipulateurs se distinguent de ceux de la translation par la présence de petits 
cubes et non de flèches. Les principes restent globalement les mêmes. Nous 
précisons juste qu’il existe un raccourci clavier intéressant à connaître. En 
sélectionnant un manipulateur et en maintenant la touche CTRL appuyé, les 
variations ne sont font pas par rapport à l’axe choisi mais sur les deux autres axes. 
Ainsi on peut effectuer facilement des gonflement/rétrécissement d’objet en ayant un 
facteur identique de variation sur deux axes en même temps : 
 
 
 

      
 
 
 
Pour l’outil homothétie, il existe en plus un cube central qui permet d’appliquer les 
variations sur les trois axes en même temps.  
 
Autres raccourcis pratiques : 

• F : cadre la vue sur l’objet sélectionné (zoom et translation automatique) 

• Z : UNDO  
 
 
 
 

L’OUTLINER (Menu > Window > Outliner) 
 
Il s’agit tout simplement d’une fenêtre listant les éléments composants notre scène, 
c’est à dire aussi bien les objets géométriques que les lampes ou les caméras… 
L’outliner peut être très pratique pour retrouver certains éléments à condition d’avoir 
fixé des noms clairs et explicites. Nous retrouvons ici des méthodes de production 
similaires à celles que l’on trouve dans nos projets de développement informatique. 
Cette fenêtre a le défaut d’être flottante : elle reste en permanence au dessus de la 
fenêtre de MAYA. Ceci la rend énervante à utiliser et pour faciliter son usage, il est 
plus simple de réduire la fenêtre de maya et de caler la fenêtre de l’outliner à son 
côté (comme ci-dessous). A notre niveau, nous n’aurons pas un besoin évident de 
cet outil, mais dès que les projets se compliquent, l’outliner devient un outil aussi 
important qu’un explorateur de fichiers. Evidemment pour faciliter la hiérarchie des 
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objets présents dans une scène, des groupes peuvent être créés, dupliqués ou 
encore déplacés dans un autre groupe (Menu > Edit > Group / Ungroup, le 
déplacement se font dans l’outliner en sélectionnant glissant avec le MMB). L’outliner 
est aussi un moyen de voir tous les objets, c’est à dire même les objets cachés par 
Maya comme la lampe par défaut ou les caméras front/top/side/pers.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
SHORT HELP 
 
Il s’agit de la fenêtre qui se trouve la plus en bas. Elle vous indique à tout moment et 
dans la limite de ses moyens des informations utiles sur l’outil en cours d’utilisation. Il 
peut s’agir des coordonnées relatives de translation, de l’ordre des objets à 
sélectionner pour effectuer correctement l’opération en cours… 
 

 
 
 
 
 
LE MENU DYNAMIQUE 
 
Un menu statique aurait été trop restreint pour présenter toutes les fonctionnalités de 
MAYA. Ce logiciel est une vraie usine car il rassemble plusieurs spécialités de métier 
comme la modélisation, l’animation, l’application de textures, le rendu et bien 
d’autres encore. Ainsi, un modeleur, notre sculpteur virtuel, va utiliser principalement 
l’interface de « Modeling ».  De cette façon, en choisissant la bonne option dans la 
boîte de sélection en haut à gauche, il personnalise son menu pour sa tâche. 

Caméras par  
défaut (hidden) 
 
Objet géométrique 
 
Icône désignant 
un groupe 
 
Lampes par défaut 
(hidden) 
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Comme nous sommes nous amenés à passer d’un mode à l’autre, vous remarquerez 
que les six premiers items du Menu restent inchangés. Nous aurons toujours : File – 
Edit – Modify – Create – Display et Window. Les autres items sont modifiés. De plus, 
ils ont varié au cours des différentes versions de Maya. Petite remarque, lorsque 
vous ne trouvez plus un item dans votre menu alors que vous l’aviez utilisé quelques 
secondes avant, vous avez durant vos manipulations clavier/souris (parfois 
rocambolesques) pu permuter sans vous en rendre compte le mode en cours et 
modifier votre menu. Pensez donc, quand cela vous arrive, à vérifier le mode actif.   
 
 

 
 

 
 
 

 
 
 
 
 
L’ETAGERE (SHELF) 
 
 
Il s’agit de la traduction du terme SHELF désignant depuis longtemps sous Maya le 
groupe d’icônes de raccourci se trouvant sous le menu. Il est très pratique 
d’utilisation. Mais dans quel état j’erre ? C’est ironiquement la question que vous 
vous poserez après avoir créé un cube qui sera déclaré comme ne possédant pas de 
faces !! En effet, les menus correspondant aux NURBS et aux polyèdres ont 
malheureusement des icônes très ressemblants. Il est donc très facile de les 
mélanger et de créer une surface NURBS à la place d’un polyèdre. Beaucoup de 
fonctionnalités sont présentes dans l’étagère et dans les menus. Cependant, il faut le 
dire, beaucoup ont été rajoutées pour séduire les novices. On trouve par exemple le 
cône, le tore, la pyramide, le tuyau qui sont loin d’être utiles pour le professionnel 
réalisant un visage ou une voiture. Cependant, pour nos exercices, ces fonctions 
resteront agréables à utiliser. Pour une utilisation plus en profondeur de Maya, il vous 
sera obligatoire de faire un tri entre les fonctions nécessaires et les fonctions 
superflues afin de diminuer la quantité d’information.  
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LA BOITE A CANAUX (CHANNEL BOX) 
 
 

Créez d’abord un cube en polyèdre. Nous remarquons 
que cette classe d’objets s’intitule polyCube sous Maya. 
La Channel Box désigne une fenêtre donnant accès aux 
paramètres principaux d’un objet ainsi qu’à son historique.  
Pour l’ouvrir, il faut cliquer sur un icône en haut à droite de 
l’application. Dès qu’un objet est sélectionné, vous voyez 
immédiatement les informations s’afficher. Vérifiez que 
l’icône « Channel Box » est actif. Cela a pour effet de 
retirer la gestion des calques, inutile à notre niveau. Nous 
pourrons ainsi gagner un peu de place utile. En haut de la 
fenêtre, vous allez trouver les trois informations qui 
définissent le repère local de votre objet, c’est à dire la 
translation, la rotation et l’homothétie suivant chaque axe. 
En modifiant ces valeurs à la main, vous changez 
immédiatement la position et la taille de votre objet dans 
l’espace. Il faut savoir que ces valeurs sont appliquées au 
repère courant qui les applique aux objets et aux sous-
repères qui lui sont attachés et ainsi de suite par cascade. 
Ainsi si vous avez un Scale de 0.5, cela veut dire qu’un 
cube de longueur 4 dans ce repère apparaîtra comme un 
cube de 4*0.5 = 2 dans l’espace. Mais, dans sa définition, 
le cube reste de longueur 4 !!! En bas dans les « Inputs », 
vous allez trouver tous les paramètres qui définissent 
votre objet cube, comme la longueur de ses côtés suivant 
chaque axe. Ceci sous-entend que cet objet permet de 
modéliser des parallélépipèdes et pas seulement des 
cubes !!!  Les « Subdivs » vous indiquent combien de fois 
vous voulez subdiviser (redécouper) votre polyèdre. Ainsi 
pour une sphère modélisée en polyèdre, cela permettra 
d’augmenter son nombre de facettes et donc d’augmenter 
la qualité de sa représentation. Testez cela avec les 

divers objets polyèdres disponibles : cube, sphère, tore… 
 
 
L’HISTORIQUE (history) 
 
L’historique représente une fonction très importante de Maya. Elle se trouve dans la 
partie INPUTS de la Channel Box. Lorsque vous créez un objet, vous appliquez des 
opérations successives pour l’améliorer. Maya associe à chaque opération une 
fonction appliquée à l’objet courant. Ainsi après quatre manipulations par exemple, 
l’objet courant est obtenu par calcul de op4(op3(op2(op1(objet_départ)))). Dans 
l’historique, nous retrouvons ces informations sous forme d’un empilement : op4 op3 
op2 op1 et objet_départ. En cliquant sur chacun de ces items, vous accédez à leurs 
paramètres internes. Créez un polyCube, passez en mode objet F8, sélectionnez le 
et demandez un smooth (7.0 : Modeling > Polygon, 8.5 : Polygons > Mesh > 
Smooth). Vous obtenez un maillage plus lisse. Sélectionnez le polyCube dans les 
Inputs et modifiez ces paramètres, vous constaterez que cela se répercute 
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immédiatement sur l’objet final. En sélectionnant le polySmooth, vous allez faire 
varier le paramètre « Divisions » qui correspond au niveau de finesse demandé. 
Faites le varier de 1 à 4. Vous voyez directement les modifications apparaître à 
l’écran. Après cela, vous pouvez revenir aux paramètres du polyCube et les modifier, 
le résultat courant correspondra à l’évaluation « polySmooth(polyCube) » chaque 
objet et opération ayant ses propres paramètres. Dès que les objets vont devenir 
plus complexes, l’historique va s’allonger. Le principe reste identique, à tout moment 
vous pouvez revenir à n’importe quel niveau et modifier un paramètre important. Il 
s’agit, comme nous le verrons dans certains exercices, d’une fonctionnalité très 
pratique. En effet, une fois votre modèle dessiné, on veut généralement effectuer 
quelques petits réglages d’appoint. Grâce à l’historique, vous pouvez parfois 
effectuer une modification très rapidement alors que dans d’autres circonstances, il 
aurait fallu détruire votre objet et repartir de zéro. Il faut cependant relativiser cette 
capacité. En effet, si vous modifiez par exemple la position d’un sommet de votre 
objet lissé (mode sommet F9) et qu’après vous changez le paramètre « divisions » 
du smooth, le logiciel ne va pas pouvoir réagir correctement et des accidents 
pourront arriver, ce qui reste cependant compréhensible. 
 
   

Modification dans l’historique des paramètres d’un cube lissé 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

   Modification de la hauteur                                      Modification du niveau de lissage 
           dans polyCube1                                                    dans polySmoothFace1 
 
Il est évident qu’une telle facilité a un certain coût. Si l’objet courant commence à 
devenir très complexe, il faudra à un moment « purger » l’historique. Une fois que 
vous êtes satisfait par vos réglages et que vous êtes sûr que vous n’aurez pas à 
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revenir sur vos pas, vous pouvez alors vider l’historique de construction de votre 
objet. Pour cela passez par : Edit > Delete (All) By Type > History 
 
 
 
 
L’ATTRIBUTE EDITOR (F8 mode objet + CTRL-A) 
 
 
Cette interface va plus loin que la Channel Box qui fournit uniquement des 
informations sur les repères locaux et les opérations stockées dans l’historique. 
L’Attribute Editor est une fenêtre permettant d’accéder à TOUS les paramètres 
définissant l’objet sélectionné, c’est à dire : les repères, les opérations appliquées, 
les textures, les modèles d’illumination, les paramètres de rendu, des options 
diverses et bien d’autres choses encore… Si jusqu’ici les interfaces de Maya 
semblaient simples, elles masquaient toute la complexité de ce logiciel. Ici, en 
ouvrant l’Attribute Editor, vous entrapercevez la complexité de la mécanique interne, 
c’est comme ouvrir le capot de voiture !!! Nous n’entrerons pas dans les détails de 
cette interface, car cela dépasserait largement le cadre de ce chapitre. Nous allons 
juste donner un exemple simple & utile. Créez un cube et accédez à sa Channel Box. 
Pour être dessiné dans les vues 3D, un modèle d’illumination par défaut est associé 
à chaque nouvel objet, il s’agit d’un Lambert (~réflexion diffuse uniquement). Cliquez 
sur l’onglet portant le nom de « Lambert1 » et double cliquez sur le rectangle à droite 
de « Color ». Vous pourrez ainsi modifier la couleur de l’objet. Cette modification se 
répercute immédiatement sur tous les autres objets partageant un « Lambert1 » !! 
C’est à dire tous les objets ayant une texture par défaut !! 
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UNDO / REDO 
 
Vous pouvez utiliser les habituelles commandes UNDO/REDO (Z – CTRL  Z) 
disponibles dans le menu > Edit. Lors des TPs où nous ferons des modèles très 
simples ou si vous avez beaucoup de mémoire physique sur votre machine, vous 
pouvez demander une taille d’historique – illimitée – ou plutôt une taille non limité 
aux dernières 50 opérations.  Pour cela, allez dans : 
 

Window > Settings/Preferences > Preferences > Undo > Infinite  
 
 
 
 
 
 
 
 
 
 
 


